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Chapter 1: Introduction and Setup

1.1 Introducing the IGSS Soft PLC, ZTTCPMON

7TTCPMON is a software PLC which can be used to simulate a real PLC and test configurations.
The soft PLC works together with the Generic TCP/IP driver - ID 34.

The soft PLC has the following features:

e can send and receive values, arrays and strings to and from IGSS

e can send and receive alarm bits

o supports four different data modes - BYTE, WORD, DWORD and FLOAT
e Supports up to 8 nodes

e Simulates a real PLC allowing you to get real driver alarms

The soft PLC looks like this. In this case, the user has double-clicked on Word number 0 to send a value to IGSS.

TCPMOK  Support for 8 Modes [o || = || £ |

DATAMODE
0001 00000 #0000
0002 00000 #0000 BT
0002 00000 #0000 -

0004 00000 #0000
0005 00000 #0000
0006 00000 #0000
0007 00000 #0000 ) D'wORD
0003 00000 #0000

Q009 00000 #0000 I FLOAT
0010 00000 #0000 5

@ WoRD

Connected DEInput @

Yalue baze

@ Hexadecimal DE Index 0000

D Decimal DE Value 6.0

Send Walue, Aray or Sting
@ Value (7 Aray 1 String

Cancel | | OKMNoSend || OK Send




For a live example using 7T TCP Monitor, watch this video:

IGSS OPC Client and Server

1.2 Activating the Generic TCP/IP driver
Before you can make use of the IGSS Soft PLC, you must activate the Generic TCP/IP driver, ID 34.

1. Open the System Configuration module.
Select the station from which you will be using the soft PLC.
Click the Add Driver icon in the toolbar or right-click the station and select New Driver.

Click the header of the ID column to sort by ID. Scroll down to find ID 34.

i A W N

Double-click the driver as shown below.

Zelect Communication Driver @

Select a communication driver to be installed from the list
below. Then click OFK.

Diriver ID Description -
Q fTDUF 30 Dupline Modem Interface 0 3031
Q FTSAT 31 SattBus Bakbit!s Protocaol Driver
Q FTCMM 32 CMM 7000 Protocal Driver
Q 7TP54 33 @rum & Jensen PS4 Protocol Driver E
= Generic TCPAP Driver M
Q 113 35 B&K 1307 IEEE 483 GFIE Interface Driver
Q FTPMET 36 P-NetVIGO Interface Driver
Q FTS7TS 37 Siemens 57 TeleService adapter interface driver
Q FTFPC 38 FPC Lund-Peterzen & Andersen protocol driver
Q FTA1800 39 Alarmret driver for 41300
Iﬁ FTOrCMkRA A ADD DTkd Cobmimdmnd membmimm | Arinmr w7
1 ] b

Q. ] [ Cancel

6. Click the + sign beside the driver name and select the interface icon named ZTTCP. Right-click and select
New Node.
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7. By default, a node is set up to be running on the local host. This can be changed to a remote IP address, if

required.
Configuration name: demo Node Properties | .-’-'-.u:lvanu:ed|
—g Demostation _ _
i ® Generic TCP/IP Driver Connection Properties:
s TTTCP - Specify TCPAP parameters and 1G5S node number for
: . thiz node.
: MNode 0 EiSS p ber D—
- B MODBUS/GPRS driver MIOCE NUMBEL o -
. | TCPAP parameters:
+- e Siemens 57 TCPAP protocol dri
Local [P Address: 0000
----- CP1
Rermate P Address: 127.0.01
Local Socket number [port number]: 0 =
Femote Socket number [port number]; 12333 =

8. Ifrequired, you can add as many as 8 nodes. The soft PLC supports up to 8 nodes.

9. The driveris now activated and ready to run with IGSS Soft PLC. Make sure that Run Simulated is not
selected on the Data Collection tab.

10. In the File menu, select Save and Exit.

11. Continue with the topic: Auto-starting the IGSS Soft PLC.htm

1.3 Auto-starting the IGSS Soft PLC

When you are using the soft PLC, you may want to auto-start it everytime you start the IGSS configuration. Do the
following:

1. Open Windows Explorer.

2. Navigate to the folder containing the current IGSS configuration.



3. Create a subfolder named Startup.

4. 1In this folder, create a shortcut to the soft PLC executable:
[IGSS InstallPath]\Gss\7TTCPMON.exe

What item would you like to create a shortcut for?

This wizard helps you to create shortcuts to local or netwark programs, files, folders, computers, or
Internet addresses,

Type the location of the itern:
CAIGSSR0Ygssh Tthepmon.exe| ‘ I Browse... ]

Click Mext to continue,

5. Assign a name to the shortcut, for example, IGSS Soft PLC.

IGSS will automatically activate all shortcuts located in the Startup folder when you start this configuration.

If you need to manually start the soft PLC, you have two
options:

- Create a shortcut in the User Programs menu of Super-
vise

- Start the soft PLC from the Utilities subfolder of the IGSS
Start menu. The shortcut is named: TCPMON Test Soft
PLC.




Chapter 2: Functionality

2.1 DBInput

In DBInput you can either choose hexadecimal or decimal as the basis. The type can either be a number, an array or
a string.

DBInput |

Baze
% Hewadicimal | DB Index IUUUD

" Decimal DE alue |m

"Send Yalue, Array ar Sting

™ Yalue  Apay T Shing

Cancel | OK MoSend || 0K Send |

2.2 Sending an array

1. Make a test object in IGSS, for example a table object with three values, "Address type" WORD and offset 1.
Choose 7TTCP as driver on the Edit Mapping tab.



— PLC Mode for object: £

Crrivver

Mode :

— PLC &ddrezs for High Alarm atonm;

D ata type: WiORD -

Offzet;

— Alarm Details

Bit Offzet

R

Hew | Edit | Defete | External tupe  |FP16
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2. Double click element number 2 in 7T TCP Monitor and enter the value "1". Click Ok NoSend.
3. Double-click element number 3, enter "2" and Ok NoSend.

4, Double-click element number 4, enter "3" and Ok NoSend. Choose element number 2, choose "Array" and
enter "3". Click Ok Send. Your table object should now show 1, 2 and 3.

2.3 Sending a number

1. Make a test object in IGSS, for example of the type Analog, and choose ZTTCP as driver on the Edit Map-
ping tab.

2. Choose Data type Word and Offset 0. As default, the values in 7T TCP Monitor are sent to the object and
hence there is no need to scan it.
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3. Double click index 0 in 7T TCP Monitor. A dialogue, DBInput, appears. Set DB value to 1 and click OK
Send. Your test object should show 1.

DBInput |

Baze
% Hewadicimal | DB Index IUUDD

€ Decimal DE Value |m

(Send Walue, Array or String

™ Yalue  Apay € Shing

Cancel | OK MoSend || 0K Send |




2.4 Sending a string

1. Make a new test object in IGSS of the type "String" with Data type WORD and Offset 2.

2. Choose 7ZTTCP as driver on the Edit Mapping tab.

—Atom — PLC Mode for object: t
Drriveer :
MHaode
[ Lo Lirnit — PLC &ddrezs for High Alarm atom;
[ L Al armm
[C1Adarmeln =l D ata type: IWDHD "I
[/0 maode : i1 = Offzet; IEI 3:
— Alarm Detailz
Bit Offzet Il:l 3:
new || Edt | [Deeel | ||| E#emsltes jFF1s =
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3. Double- click element number 3 in 7T TCP Monitor, choose String as type and enter "Test". Click Ok Send.
Your object in IGSS should show "Test".

2.5 Scan / event

As default 7T TCP Monitor is event driven and the objects do not need to be scanned. If you want to test the scanning
of objects, this must first be chosen in IGSS.

1. Right- click an object, click the Data Management Definitions tab. For example, choose a Scan inter-
val of 2000 msec.



2. In 7T TCP Monitor, double-click an element belonging to the object, which should be scanned. Choose a
type and enter a value. Click "Ok NoSend" to send it to 7T TCP Monitordatabase. IGSS will scan the object
for changes and copy the value to the object.

2.6 OnTop

This option can be used to maintain the Tcpmon window On Top of IGSS while testing.



3.1 Using 7ttcpmon



Chapter 3: Reference and Lookup

3.2 Conventions in this Manual

The following typographical conventions are used:

Convention Description Example
User inter- When referring to labels and names
face ele- . . The Data Management tab.
in the user interface.
ment
. When the user has to type specific U2 iRl el sl
Userinput | 4 ta in 1GSS
' Incoming flow in Tank 2
Module . ) .
name When referring to a module in IGSS Open the Definition module.
By default, the times-
A note emphasizes or supplements tamp is in universal
Note important points of the main text. A time format, 1
note provides information that may This can be changed in
apply only in special cases. the Driver Log Filters
dialog box.
A tip suggests alternative methods
that may not be obvious in the user
Tip interface. A tip also helps the user in
working more effectively with IGSS.
A tip is not essential to the basic
understanding of the text.
A warning is an important note that is If you disregard the
essential for the completion of a System alarm, you
Warning task. In some cases, disregarding a may risk loss of data
warning may result in undesirable in the and
functionality or loss of data. files.

lUniversal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in most parts of
the world. IGSS uses this time format internally in the database. You can switch between UTC and local time by ena-
bling or disabling the "UTC" field in various dialog boxes in the system.



3.3 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and operators to get started
with IGSS as quickly as possible.

Documentation overview

The IGSS documentation includes the following items:

Documentation item Description

An introduction to IGSS and its most fundamental terms and features. Getting
Started is intended to get you up and running as fast as possible. The manual
Getting Started provides a system and architecture overview followed by a number of real-
life use cases you can go through before building your first real IGSS project.
The manual is available in Adobe Acrobat format (.pdf).

For each module there is a help file with the same name as the module itself,
for example, Igss.chm for the Master module, Igss.exe.

The help file is invoked by clicking the in the upper right corner of the mod-
ule. The Table of Contents will then allow you to browse through the topics.

Module help

For each dialog box there is a help topic with the following standard infor-
mation:

Overview

Preconditions
Where do I find it?
Field help

Dialog box help

Dialog box help is invoked by clicking the help button in the upper right hand
corner of the dialog box.

IGSS also provides thematic help. When there is a special theme that requires
Thematic help special attention from the user, a dedicated help file is provided. Examples
include "Driver-Specific Help" and "Database Administration Help".

Where are the help files located?

The IGSS help files are located in the appropriate language folder under the [IGSS InstallPath]. The help files are
available in English at release time.

The paths to the help files are:



Language Path

English [IGSS InstallPath]\ENG
Danish [IGSS InstallPath]\DAN
German [IGSS InstallPath]\DEU

Translated help files

Selected help files have been translated into Danish and German. If you require help files in your language, please
contact 7T.

Help updates

The IGSS help files are continuously updated and improved. Check regularly with the IGSS Update module in the
IGSS Start menu.

3.4 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 8.0

The IGSS help files are based on software build number 9212 (initial release)

English help files

To update the help files, you must activate the IGSS Update module in the IGSS Start menu. There must be a con-
nection from the PC to the Internet. Every time IGSS Update is run, IGSS help files as well as IGSS system files will
automatically be updated on the PC from the 7-Technologies web server.

You select the languages you want to update in the Tools menu of the IGSS Update module.

If you are not able to update the IGSS system directly via the Internet, the alternative is to download the updates
from the 7-Technologies website as zip files. These can then be transferred onto a CD or USB memory stick, which is
then the medium used to update on site.

After running , the build numbers in various
IGSS modules may change to a higher number. This signifies
that the module in question has been updated with newer
files. Build numbers consist of four digits, where the first digit

represents the year and the last three represent the day
number in the year in question. The build number can be
seen in the About dialog box which can be activated from
the Help menu.

An example:



Build number = 9212
9 = the year 2009
210 = The 210th day of the year



Chapter 4: Glossary

A

Application button
The Application button, nicknamed "doughnut", is located in the upper left corner of the module's window.
Click the button to access the application menu. The menu contains items that were typically found in the
File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define
global module settings. The Application button is a new term introduced with the .NET platform and used in,
for example, the Microsoft Office 2007 package.

atom

H

HDM
HDM is the abbreviation for Hour-Day-Month.

Q

Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply drag the
relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known toolbars
in applications. The Ribbon provides quick access to the most commonly used functions in the application.
The Ribbon is divided into logical groups (the tabs) and each tab is divided into sections (the blocks in the
tab). The Ribbon is context-sensitive which means that only relevant functions are accessible dependent on
the current user action.

S

SCADA
Supervisory Control & Data Acquisition




U

uTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in
most parts of the world. IGSS uses this time format internally in the database. You can switch between
UTC and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.



	Chapter 1: Introduction and Setup
	1.1 Introducing the IGSS Soft PLC, 7TTCPMON
	1.2 Activating the Generic TCP/IP driver
	1.3 Auto-starting the IGSS Soft PLC

	Chapter 2: Functionality
	2.1 DBInput
	2.2 Sending an array
	2.3 Sending a number
	2.4 Sending a string
	2.5 Scan / event
	2.6 OnTop
	3.1 Using 7ttcpmon

	Chapter 3: Reference and Lookup
	3.2 Conventions in this   Manual
	3.3 Getting Help in IGSS
	3.4 Version Information (IGSS Help System)

	Chapter 4: Glossary

